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Welcome 

A helpdesk system integrated seamlessly within your Microsoft Office Outlook, transforming it from a simple email client 

to a fully-fledged service provider.  

This is an elaborate help documentation that will guide agents on how to install, configure, and work with support 

cases in Outlook. Graphic illustration and screenshots of the screen/forms are used with proper marking wherever 

they are required to drive down the point of the relevant topic.  
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1. Helpdesk that is designed for Outlook 
 

The AssistMyTeam Helpdesk is an issue tracking and ticketing system that is available as an add-on for Microsoft Outlook. 

Integrated seamlessly within your Microsoft Outlook, it transforms Outlook from a simple email client to a fully-fledged 

service provider. Using your inhouse Microsoft SQL Server or cloud Azure SQL as repository for storing support cases, it 

provides support staffs with all the necessary tools to log, collaborate, analyze and assist in the resolution of help desk issues. 

Various medium of communication supports automated messaging and notification requiring no human inputs, making it 

possible to integrate customer relationship management (CRM) processes in core help desk functionalities 

With inbuilt support for advanced statistics and varied reporting options, support managers can evaluate the performance of 

the helpdesk and in-turn ensures timely decision making for improved service.  

To sum up, AssistMyTeam Helpdesk improves the efficiency of the help desk to enable faster response time and higher 

productivity for your organization at lower operating costs. After all, the bottom line for your help desk team is for your end-

users to receive better and timely service. 

Benefits for your organization: 

 Work on cases in your Outlook as if you would work on emails 

 Single enterprise-wide view of support cases, callers, problems and resolutions 

 Little or no training requirement on the part of your support agents 

 Centralized data storage on Microsoft SQL Server or Azure - efficient platform for collaboration 

 Enable integration with Active Directory  

 Common point-of-call for your callers 

 Structured workflow for all helpdesk activity  

 Freeing up valuable human resources by automating cases logging, sending notifications etc. 

 Higher productivity and increased "up-time" for support staffs  

 Organized state of cases means faster tracking requests 

 Identify problem areas and increase helpdesk efficiency  

 ‘Do more with less’ - affordable one-time fee with enterprise-wide license 

 

Benefits for your customers:  

 Always in communication loop via the power and ease of automated email/messaging 

 Inspires confidence to the help desk service 

 A knowledge base that can be searched through for resolution 

 Check on the progress or status of the case via web 

 Request support in a standardized way through email  

 Case gets resolved in a timely manner and hence customer satisfaction 

 Helps in building trust and loyalty in your brand 
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2. How It Works?  
AssistMyTeam Helpdesk System consists of two separate installs – Managerial and Agent. 

 

• The Managerial install is for helpdesk administrator who would configure and maintain the global configurations, drop 

down lists, templates etc. in the helpdesk SQL database. 

 

• The Agent install is for the technicians to enable them to log, raise and work on support cases in Outlook. 

 

Each of this tool is installed on individual computer as an extension to Microsoft Outlook and only relies on Microsoft Outlook for 

the front-end and a network SQL or cloud Azure database, as the back-ends.  

 

   

Step 1 
Manager creates a central helpdesk 

database 

After the managerial tool is installed, helpdesk 

administrator will be given a choice of database 

options where all the cases, articles, templates and 

other settings data will be stored centrally.  

Database options include Microsoft SQL Server, 

Microsoft Azure (cloud SQL server).  
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Step 2 
Manager configures helpdesk settings 

and drop downs 

Helpdesk administrator defines drop-down lists 

such as agents, callers, problems as well as 

emails templates, messaging options etc. With 

these global settings, manager can streamline 

the behavior on how all agents work on support 

cases in Outlook. 

 

 

 

Step 3 
Technician installs Agent add-in 

The Agent tool consists of an Outlook add-in 

that has all the logic and functionalities of the 

helpdesk application. Each agent of the 

helpdesk who would work on cases needs to 

install the Helpdesk Agent tool. 

After a successful install, you will see that 

dashboard panel, toolbars or ribbons are 

added in the explorer and inspector windows 

of Microsoft Outlook. 

Note: Apart from the managerial tool, helpdesk 

administrators also need to install the Agent tool if they 

have to work on support cases themselves. 
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Step 4 
Caller submits support request via 

email or phone call 

An end-user experiencing technical challenges 

contact helpdesk requesting for support by 

sending an email or by making a phone call. 

These support requests are then logged and 

converted to cases in Outlook.  

Further details and drop-down lists (such as the 

classification of problems the request falls into) 

can then be set, by a supervisor or manager. 

 

 

 

 

Step 5 
Assign agents to the case 

Typically, a manager assigns the best agents to the case for 

fulfillment of the service and speedy resolution.  
 

Furthermore, in the helpdesk settings, administrator can link and associate individual agent to a caller, or to a problem type such 

that when a new support request email is received, if there is a match between agent and the caller (read as sender), or if a 

problem type is found in the email subject, the associated agents will get assigned automatically to the case. 

Assigned agents then get notified through an automated email. Optionally, the due date of the case is entered into the personal 

calendar of the agent’s mailbox. 
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Step 6 

Agents collaborate to resolve the case 

The assigned agents then proceed to fulfill and resolve the case in Outlook. Helpdesk manager may set due date and other 

deliverables on the particular case for the assigned agents, for quality check purposes. Further correspondence to the caller might 

follow (in the form of emails, phone calls). All activities related to the case are logged and agents can fill time spent and assign 

additional agents if needed. All email conversations and notes can be accessed and tracked right from the case form itself, without 

the need to scan through your Inboxes for past replies. 

 

Step 7 

Caller follows-up via email 

The caller can reply back to email from the helpdesk and the response automatically triggers an escalation on that particular 

support case. If a response from the caller on an existing case is received, the assigned agents are notified automatically. If the 

case has been resolved, AssistMyTeam Helpdesk automatically re-opens and marks it as an ongoing case. 
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Step 8 

Agent closes case after providing a 

resolution 

Once every parameter of the caller's request has 

been fulfilled, a case be closed. At the same time, 

the caller gets notified automatically on the 

closure of the case. 

 

  

 

Step 9 

Agent adds resolution to knowledge base 

A closed case can be a good source of future reference and agent can create a new knowledge base entry based on the case. It is 

then available in the list of articles under the integrated knowledge base, categorized and sorted, ready for your agents to draw from 

when similar issues arise. Additionally, helpdesk administrator can choose to publish these articles to their website or intranet to 

provide first level support to potential support requests from end-users. 
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Step 10 

Manager generates statistical and trend reports 

To identify problem areas and increase helpdesk 

efficiency, senior management runs the 

statistical tool from time to time, collecting 

valuable intelligence and trends and generating 

meaningful reports.  

 

For day to day knowledge of the helpdesk, they 

can generate summary reports to get appraisal 

on the current happenings on the helpdesk and 

track recent cases generated, worked, closed or 

reopened. 
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3. Requirements  
AssistMyTeam Helpdesk is available right inside your Outlook unlike any other standalone application and web-based help desk 

software. It can be easily deployed through an installer (manually or via a group policy object with MSI) across the entire 

organization. 

 

Please make sure that your system meets the following requirements before installing AssistMyTeam Helpdesk for Outlook: 

Windows Version  Windows Vista, 7, 8, 8.1, 10, 11. Both 32-bit and 64-bit OS are supported.  
  

Outlook Version  Outlook 2019, 2016, 2013, 2010. AssistMyTeam Helpdesk operates directly inside the 
Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook 
Express is not supported.   
  

Database  

  

All versions and editions (including Express edition) of SQL Server are supported including 

cloud services such as Amazon RDS and Microsoft Azure SQL. 

 

.NET Framework  Microsoft .NET Framework 4.6.1 

 

  

.   
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4. Installation Information 
This install is meant for agents and technicians who would be working on support cases from within their Outlook. Before you install 

the agent tool, make sure the helpdesk SQL database had been already created and configured by your manager, and that you know 

the database name, your credentials to the SQL server if Windows authentication is not configured (ask your helpdesk manager). 

This is required because when you start Outlook after installing the Agent add-in, you will be asked to enter the SQL server logon 

information as well as the database name (if different from the default name ‘AssistMyTeamHelpdeskDB’). 

Download link: SETUPS 

There are two different setup types: 

For 'Per User Installation' (ideal for standalone single user/workstation) 

AssistMyTeamHelpdeskSetups_x86.zip (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskSetups_x64.zip (for 64-bit Outlook 2010, 2013, 2016, 2019) 

For 'Per Machine Installation' (ideal for installing on Citrix and Terminal Servers) 

AssistMyTeamHelpdeskSetups_x86_Citrix.zip (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskSetups_x64_Citrix.zip (for 64-bit Outlook 2010, 2013, 2016, 2019) 

The downloaded zip file contains 3 files: AssistMyTeamHelpdeskManagerSetup_xXX.exe, 

AssistMyTeamHelpdeskAgentSetup_xXX.exe and VersionInfo.txt where ‘xXX’ can be either x86 (32-bit Outlook) or x64 (64-bit 

Outlook) 

Extract these file contents to a file folder. It is recommended that you place the setup files on a shared network folder, such that all 

users can have access to it, and ease the installation and upgrade process. 

Per User Installation and Per Machine Installation 

In Per User Installation, both the Manager and Agent installs are performed 100% on the local system and nothing is installed on 

your Exchange or Windows Server. Further, this install is intended to serve only the current logged on user of the 

system/workstation and will be installed under the user's application data folder (instead of Programs Files folder) and no elevated 

permission is required (This is known as per user installation). So, there won't be a prompt from UAC to allow this install unless you 

change the install directory to say, Programs Files which will warrant an elevated permission/UAC prompt. If the same system is 

used by multiple agents, each user needs to install AssistMyTeam Helpdesk add-in on their profile with the default installation 

folder location. 

Per Machine Installation: If you have the need to have a single install that serves all users of the system (i.e., per machine 

installation, which technically means the files will be installed under Program files folder and the add-in will be registered under 

HKEY_LOCAL_MACHINE registry hive rather than HKEY_CURRENT_USER), download the Citrix/Terminal Server version of the 

setups to perform a per machine installation. 

 

The Agent setup is of two different types - one each for 32-bit Outlook and 64-bit Outlook 

For Per User Installation: 

AssistMyTeamHelpdeskAgentSetup_x86.exe (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskAgentSetup_x64.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

 

For Per Machine Installation: 

AssistMyTeamHelpdeskAgentSetup_x86_Citrix.exe (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskAgentSetup_x64_Citrix.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

 

Note: if the administrator/manager needs to work on support cases, the agent tool also needs to be installed, apart from the 

managerial portion. It is perfectly normal to have both Manager and Agent add-ins installed on the same machine. However, for 

normal agents, just the agent add-in is enough to work with the support cases in Outlook.  

https://www.assistmyteam.com/helpdesk-addins/download-setup/team-helpdesk-for-outlook/
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4.1 Installation Steps  
 

The Agent installation mainly consists of an Outlook add-in that has all the logic and functionalities of the helpdesk 

application. It needs to be installed by all agents who will be working with cases in Outlook. Before you continue the 

installation, it is recommended that Microsoft Outlook is shutdown (if active). 

Step 1. Run the AssistMyTeamHelpdeskAgentSetup_xXX.exe to start the installation. Click 'Next' to Continue. If Outlook 

2010 or later is not installed, the setup wizard will not be able to proceed. Please also ensure Outlook is shutdown (if already 

running or active in the task manager) as the setup has to install an Outlook add-in. 

 

 
 

Step 2. Select the appropriate destination folder where the application files will be installed. If you change the default 

folder path, please make sure you have appropriate permission. (Note: by default, it will be installed under your application 

data folder) 
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Step 3. Click 'Next' to continue with the files extraction. It just takes a few minutes to complete the whole copying process 

  
  

Step 4. Click 'Finish’. This ends the files installation process in your system. Now start Microsoft Outlook 

  

Now start Microsoft Outlook. If the agent add-in installation was successful, you will see a new menu item 'AssistMyTeam Helpdesk’ 

in Outlook (after help menu).  
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4.2 Establish connection to helpdesk database 
 

The final step is linking up your Helpdesk Agent add-in with a configured SQL Server database. When you start Outlook, you will be 

prompted to enter the SQL Server details so that the add-in can link up with the existing helpdesk database. 

 

Once you feed your credentials into the SQL Server or Azure Cloud, click ‘Save’ button. Consequently, the agent add-in will be 

connected to the helpdesk database, enabling you to raise new cases from emails, or view them in the dashboard panel. 
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Additional step for Agents on the SQL database. 

Make sure that you have adequate permission to access and update the tables in that database i.e., db_datareader and 

db_datawriter permission on the AssistMyTeam Helpdesk SQL database. 

 

 

The installation folder in your primary drive depends on the installation type you had chosen - Per User or Per Machine. 

For 'Per User Installation', it would be 

C:\Users\[USER]\AppData\Roaming\AssistMyTeam\AssistMyTeam Helpdesk Agent (x64 or x86) 

For 'Per Machine Installation', it would be 

 C:\Program files (x86)\AssistMyTeam\AssistMyTeam Helpdesk Agent (x86 or x64) 
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5. Working with Helpdesk Dashboards 
The helpdesk dashboards are a powerful monitoring tool. They provide an overview of the most important helpdesk metrics 

and enables identification of problems and bottlenecks in a quick glance. They are also the main interfaces with which agents 

interact with cases, articles and callers stored in the helpdesk database. Using the dashboard, agents can prioritize and track 

their performance better by getting a rundown of their case backlogs. 

 

 
 

The helpdesk dashboard contains three sections – Cases, Articles and Callers. The dashboard is refreshed every few minutes 

so that agents are looking at the information in the dashboard from the most current state of the helpdesk data. Instead of 

having to run a number of queries, the add-in runs these searches automatically, making sure that you are never looking at 

stale data. You won't have to remember to run important searches once you have selected the parameters in the dashboard - 

you'll be able to spend your time gaining insight into your assigned cases as well as overall state of your helpdesk. 

The helpdesk dashboard panel can be found attached at the bottom portion of your Microsoft Outlook. The dashboard can be 

resized, adjusted or minimized in your Outlook explorer so that you can interchangeably switch and work between your 

emails and the cases stored in your external database. 
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5.1 Understanding the general dashboard UI 

 

 

 

The Cases Dashboard section is where agents will interact and work with their assigned cases. Cases can be extracted 

from the database based on time period and/or types of incidents.  

 
The Articles Dashboard section is where agents can view or search knowledge base articles for a possible solution to their 

assigned cases. Additionally, agent can create and publish new article directly from this section. 

 
The Callers Dashboard section is where agents can see the contact details of their assigned or responsible callers. Agent 

can also instantly create new caller directly from this section. 

 
Create a new empty case in the database. A form will be displayed that agent needs to fill in the caller, problem 

information. 

 

 
To create a new KB article or a caller, choose from the menu that pops down when pressing the plus button. 
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By default, the information and data that are shown in the dashboards are from all items created or assigned to all 

agents. To filter and only show information with regards to their assigned cases, articles or callers, an agent can choose 

‘My Items’ only option. 

 
If the agent specifies some keywords, the add-in will perform a full-text search for the matching keywords on all fields of 

the case, article or the caller, including the description and consolidated conversation. 

 
The placement of the summary information can be made to change from horizontal (default) to vertical depending on 

the placement of the dashboard panel in Outlook Explorer. For instance, if you place the dashboard on the left or right 

pane of Outlook, it is recommended that you choose the vertical placement of the summary information as this will give 

you more optimum working region. 

 
The summary information are real-time readings from your helpdesk database. There are 11 boxes – 9 for cases, 1 each 

for articles and callers. You can click the number or label in the box to load and show those cases, articles or callers in the 

corresponding dashboard section.  

 

What each box means? 

Today’s New – Cases that were logged today 

Open – Cases that are ongoing 

Resolved – Cases that are closed or completed 

Not Assigned – Cases that are yet to be assigned to agents 

Not Answered – Cases that are yet to be replied to the callers since their creation. 

Breaches Today – Cases that are due today 

Breaches This Week – Cases that are due this week 

Total Breaches – the total number of Cases in the database that are due 

Total Cases – the total number of Cases, both ongoing and closed in the database 

Total Articles – the total number of articles in the database 

Total Callers – the total number of callers in the database 
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5.2 Cases Dashboard 
 

The Cases Dashboard section is where agents will interact and work with their assigned cases. Cases can be extracted from 

the database based on time period and/or types of incidents. 

 

 

Time Period 

Choose a time period from the followings under which the search will be confined: 

Any 

Today 

Yesterday 

Tomorrow 

This week 

Last Week 

Next Week 

This Month 

Last Month 

Next Month 

This Year 

Last Year 

Date Range... 

On 

  

 

 

Case Type 

Choose a report type from the predefined ones below:  

Any 

Cases Created 

Cases Resolved 

Cases Ongoing 

Cases Worked 

Cases Due 

Cases Not Responded 

Cases Unassigned 

Cases Assigned 

Cases lapsed - Due Time 

Cases lapsed - Response Time 

Cases with no Due Date 

Cases with no Response Date 

Cases with no Caller 

Cases With High Priority 

Cases With Normal Priority 

Cases With Low Priority 
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Group By 

You can choose to group the cases either with - Agents, Status, Problem Category, Problem Type, Caller, Company, 

Priority, or Author. 

 
Choose Fields or Columns 

You are free to choose which particular helpdesk fields/columns show up in the search result and report. Just click the 

'Fields' button, and choose the wanted columns to include. 

 

The tool will remember your choice in subsequent runs. You can re-arrange the columns by drag-and-drop to get the kind 

of view you want. And the display order of the columns will be retained in subsequent sessions. 

 
Show Cases 

Click this button to search the helpdesk database for Cases that match the parameters you had specified. 

 

 
List of Cases 

The listings of Cases from the database. To open and view a particular case item, select it from the listings and click ‘Edit’ 

button (located in a toolbar just above the listings).  You can double-click the case item from the listings, or press Return 

key (ENTER) from your keyboard.  

To sort the cases by the column, click the corresponding column header. The sorting symbol > (ascending) or < 
(descending) will be displayed just before the column header depicting if the sorting is done in ascending or descending 

order. 
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Your choice of sorting, either in ascending or descending order will be remembered in subsequent listings.  

The listings also support context menu (i.e., right-click a selected case entry to show a popup menu with support actions 

available in a click). 

 

 
Reply to Caller 

Compose and send a reply email to the caller of the selected case. There are 3 different types of reply that can be made 

to the caller. 

 

 

  Make a reply to the caller by including all the past conversations on the case, including embedded/inline images. 

The add-in will automatically build the reply email with subject deriving from the case subject and salutation (e.g., Hi 

CALLER) embedded on the top most part of the body, and preceded by 2 empty line breaks which is where the agent can 

type in the response. And the bottom section in the body is that of the past conversations of the case. 
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 Make a reply to the caller with no past conversations i.e., with only simple salutation. The subject of the reply will 

be derived from the case subject and the add-in will make sure; the case number ID is present in it for tracking purpose. 

 Make a reply to the caller using a customized email template. This template ‘Reply to Caller’ can be accessed 

from Outlook > Helpdesk Manager > Templates Manager.  

 

 
Reply with a KB 

Choose a KB article and embed it to a reply email to the caller. There are two different ways you can make a reply to case 

with a chosen KB article. 

 

 Make a reply to the caller with a KB article and include all the past conversations on the case, including 

embedded/inline images. The add-in will automatically build the reply email with subject deriving from the case subject 

and salutation (e.g., Hi CALLER) embedded on the top most part of the body, and preceded by the chosen KB article. And 

the bottom section in the body is that of the past conversations of the case. 

 

 Make a reply to the caller with a KB article with no past conversations of the case i.e., with only simple salutation. 

The subject of the reply will be derived from the case subject and the add-in will make sure; the case number ID is 

present in it for tracking purpose. 

 
View or Edit 

Open the selected case in its inspector window in Outlook for viewing or further editing. You can also double-click the 

selected case or press return key (ENTER) from your keyboard to produce the same effect. 

 
Mark Complete / Re-Open 

If the selected case is ongoing, you can click this button to mark it complete. And if it a resolved case, you can click to re-

open it, 

 
Delete 

Permanently remove the selected cases from the Helpdesk database. You will be prompted with a confirmation. 

WARNING: This action is irreversible and so be very sure what you are removing. 



 

 

 Back to TOC 

P
ag

e2
3 

 
Merge Cases into One 

Merge the selected cases to one single case. Sometimes, a caller might contact you through separate emails or channels 

regarding a particular issue. The same issue might be logged as a case by a different agent not knowing an existing one 

already exists. To avoid duplication and conflicts, you can merge all related cases together and keep the communication 

streamlined. 

 

 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case. 

 
Export to PDF 
 

Export the selected cases to PDF document files. You can also export to Word Documents, HTML, plain text etc. 

 

 
 

Multiple cases can be batch exported. Just select multiple cases from the list and choose one of the document types to 

export to, and the batch wizard will perform the rest. 
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You can control what case data are included in the files by customizing the 'Print' template under AssistMyTeam 

Helpdesk Manager > Templates Manager. For example, place the variable 'CASE_BODY' in the Print template such that 

the exported file (e.g., pdf) contains all the consolidated conversations (body) from the case item including inline images. 

 
Print a Case 

Click this to print the selected cases using the 'Print' template (as defined under AssistMyTeam Helpdesk Manager > 

Templates Manager). If you select a single case to print, it will show you the print dialog option, where you can customize 

the layout, paper size etc. However, if you choose multiple cases, it will print directly using the default settings without 

displaying any ‘Print’ options. 
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5.3 Articles Dashboard 
 

The Articles Dashboard section is where agents can view or search knowledge base articles for a possible solution to their assigned 

cases. Additionally, agent can create and publish new article directly from this section.  

With a knowledge base, you and your team mates can document best practices and solutions to common problems so that they can 

be used when replying to time-consuming and repeated queries. Any support case is eligible to become flagged as a KB Article. An 

agent recognizing a repetitive support issue, can easily flag a resolved case as a knowledge article. Thus, it acts as an effective 

knowledge sharing medium, boosting support productivity by leveraging collective knowledge and providing invaluable KB Articles to 

support techs in a snap! It also helps in improving the average ‘First Call Resolution’ timing significantly, as agents find resolution to 

problems quickly.  

KB articles in the dashboard listings are arranged in hierarchical tree (by group KB items into 'Problem Category' and then to 

'Problem Type'). This arrangement makes it very easy to browse for a particular knowledge base at the time of need. 

  

 

Time Period 

Choose a time period from the followings under which the search will be confined: 

Any Last Week This Year 

Today Next Week Last Year 

Yesterday This Month Date Range... 

Tomorrow Last Month On 

This week Next Month  

  

 
Case Type 

Choose an article type from the predefined ones below:  

Any Personal Articles 

Articles Created Public Articles 

Articles Modified  

  

 
Group By 

You can choose to group the articles either with - Category, Type, Created by and Modified By. Here is an example of 

articles listing group by ‘Category’. 
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Choose Fields or Columns 

You are free to choose your own article fields/columns to show up in the search result and report. Just click the 'Fields' 

button, and check your columns to include. 

 

The add-in will remember your choice in subsequent runs. You can re-arrange the columns by drag-and-drop to get the 

kind of view you want. And the display order of the columns will be retained in subsequent sessions. 

 
Show Articles 

Click this button to search the helpdesk database for articles that match the parameters you had specified. 

 
List of Articles 

The listings of articles from the database. To open and view a particular article item, select it from the listings and click 

‘Edit’ button (located in a toolbar just above the listings).  You can double-click the article item from the listings, or press 

Return key (ENTER) from your keyboard.  

To sort the articles by the column, click the corresponding column header. The sorting symbol > (ascending) or < 
(descending) will be displayed just before the column header depicting if the sorting is done in ascending or descending 

order. 

Below is an example of a listing sorted by ID column. 

 

Your choice of sorting, either in ascending or descending order will be remembered in subsequent listings.  

The listings also support context menu (i.e., right-click a selected case entry to show a popup menu with support actions 

available in a click). 
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New Article 

Create a new empty article where you can compose the content. 

 
Edit Article 

Open the selected article in its inspector window in Outlook for viewing or further editing. You can also double-click the 

selected article or press return key (ENTER) from your keyboard to produce the same effect. 

 
Forward Article 

Forward the selected article to a recipient. 

 
Remove Article 

Permanently remove the selected articles from the Helpdesk database. You will be prompted with a confirmation. 

WARNING: This action is irreversible and so be very sure what you are removing. 

 
Export to PDF 
 

Export the selected articles to PDF document files. You can also export to Word Documents, HTML, plain text etc. 

 

 
 

Multiple articles can be batch exported. Just select multiple articles from the list and choose one of the document types 

to export to, and the batch wizard will perform the rest. 

 

 
 

 
Print an article 

Click this to print the selected articles. If you select a single article to print, it will show you the print dialog option, where 

you can customize the layout, paper size etc. However, if you choose multiple articles, it will print directly using the 

default settings without displaying any ‘Print’ options. 
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5.4 Callers Dashboard 
 

The Callers Dashboard section is where agents can see the contact details of their assigned or responsible callers. Agent can 

also instantly create new caller directly from this section. 

 

 

Group By 

You can choose to group the callers either by company or assigned agent. For example, below is a listing of callers group 

by Company. 

 
 

 
Customize Fields or Columns 

You are free to choose your own caller fields/columns to show up in the search result and report. Just click the 'Fields' 

button, and check your columns to include. 

 

The add-in will remember your choice in subsequent runs. You can re-arrange the columns by drag-and-drop to get the 

kind of view you want. And the display order of the columns will be retained in subsequent sessions. 
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Show Callers 

Click this button to search the helpdesk database for callers that match the parameters you had specified. 

 
The listings of callers from the database. To open and view a particular caller entry, select it from the listings and click 

‘Edit’ button (located in a toolbar just above the listings).  You can double-click the caller entry from the listings, or press 

Return key (ENTER) from your keyboard.  

To sort the callers by the column, click the corresponding column header. The sorting symbol > (ascending) or < 
(descending) will be displayed just before the column header depicting if the sorting is done in ascending or descending 

order. 

 

Your choice of sorting, either in ascending or descending order will be remembered in subsequent listings. 

The listings also support context menu (i.e., right-click a selected case entry to show a popup menu with support actions 

available in a click). 

 

 
New Caller 

Create a new empty caller where you will need to fill in the contact details. 

 
Edit Caller 

Open the selected caller to view its contact detail or further editing. You can also double-click the selected caller entry or 

press return key [ENTER] from your keyboard to produce the same effect. 

 
Remove Caller 

Permanently remove the selected callers from the Helpdesk database. You will be prompted with a confirmation. 

WARNING: This action is irreversible and so be very sure what you are removing. 

 
View Cases 

Show the cases that are allotted to the selected caller. This will load the cases in a new window. To view or edit the detail 

of a case, double-click it. 
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New Case 

Raise a new empty case for the chosen caller. This will populate the contact details of the chosen caller to the new case. 

 
Email Caller 

Compose a new email to the chosen caller. The add-in will automatically add the salutation (e.g., Hi XYZ) to the body of 

the email. 

 
Print 

Click this to print the selected callers. If you select a single caller to print, it will show you the print dialog option, where 

you can customize the layout, paper size etc. However, if you choose multiple callers, it will print directly using the 

default settings without displaying any ‘Print’ options. 
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6. Working with the Helpdesk toolbar UI 
The Helpdesk toolbars along with the dashboards are the primary medium with which agents work and interface with their support 

cases in Microsoft Outlook.  

 

 

My Dashboard 

Open a new dashboard window outside of Outlook. This is in addition to the integrated dashboard that is available in the 

lower part of your Outlook Explorer window. With this additional dashboard, you have a much larger area to work with 

your cases and articles, independent to the one available in Outlook. To learn more, refer to the ‘Working with Helpdesk 

Dashboards’ section. 

 

 
My Report Generator   

Open the summary report generator tool and generate reports on support cases quickly to be saved as file or 

printed for sharing and distribution. To learn more, refer to the ‘Generating Reports’ section. 
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My Statistics 

Open the statistical OLAP tool and analyze the cases data in multidimensional view with grids, charts and graphs. 

  

 
My Settings 

This is a drop-down menu containing tools, database connection utilities and important links to the helpdesk app, 

manuals etc. For further information on each of the available options, refer to Configuring my Settings section. 
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New Case 

Raise a new empty case. This will open a new inspector window in Outlook where you will need to fill in the problem 

subject and summary, caller details, initial status and assign it to an agent. 

To learn more, refer to the ‘Understanding the case form in Outlook’ section. 

 
Convert to Case 

Clicking this will convert an email send by a caller requesting support to a case in the helpdesk database. The add-in will 

automatically extract the contact details from the email such as sender name, sender email, phone, company 

information etc. and populate to the case.  

To learn more, refer to the ‘Raise a new case from an email manually’ section. 

 
Add to Existing Case 

Clicking this will allow you to add the selected emails to an existing case in the helpdesk database. This comes handy when 

you have emails that are related to an existing case and would like to add them to the case. 

To learn more, refer to the ‘Add an email to a case’ section. 

 
Reset link to Case 

Use this to remove any references of a case from the selected emails. References can be in the form of presence of a 

case ID in the subject of the email, or the presence of a flag on the email. Removing these references would allow you to 

raise a new case out of that email again. 

 
Create KB 

If an email contains useful information that helps in solving a problem, you can use it as a source to create a new KB 

article in the helpdesk for future use. 

To learn more, refer to the ‘Creating a new KB article’ section. 

 
Reply with a KB 

If you have received an email that is seeking for support request, and if you know there is already a KB article that 

addresses that problem, you can use this to choose that KB article and send it as a reply to the sender. A dialog window 

allows the agents to browse through the existing knowledge base articles. 

To learn more, refer to the ‘How to use the knowledge base article’ section. 
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7. Understanding the Case form in Outlook 
The support request form in Outlook is designed to log in a new case and view existing ones from the database in Outlook. 

There are four (4) sections in the form – Case, Time Spent, Notes and Related Cases. 

 

 
 

In the case section, information catering to the case, caller, agent, problems etc. are laid out in a very intuitive way. Fields 

such as problem category, type, status are available in drop down format (configurable by the helpdesk manager) so as to 

limit the choice the agent can select for such fields. Managers can assign multiple agents to a particular case if the scope of 

the problem extends beyond the capability of an agent. Automatic notification messages are sent out immediately to the 

concerned agents once the case is assigned or a due date is specified or changed. Optionally, a due date appointment or task 

can also be added to the personal mailbox of the assigned agents.  

 

In the Time Spent section, each agent can add their time spent when working on solving the case. This is particularly useful if your 

organization pays the agents by the hour. By collection time spent data from the case, manager can extract payment or billing 

information for the agents. 

In the Notes section, agents and managers can add private or internal notes to the case for reference. The add-in can also be 

configured to add such notes to the consolidated conversations of the case. 

In the Related Cases section, agent can get reference to other cases that are related in terms of having the same caller, company or 

domain. 
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7.1 Case Information 
 

The first section of the case form consists of fields related to caller, assigned agents, problems, due date etc.  

 

 

 

Case metadata 

These are meta-data fields of the case and are generally populated when the case was logged and raised. 

Case ID - The unique number that identifies the case in the helpdesk database. Every email communication out of the 

helpdesk to the callers are tagged with the corresponding Case ID (enclosed within the square brackets for tracking 

purpose. E.g., [2]. 

Received - The date/time the case (usually an email) was first received in Inbox. 

Created On - The date/time the case was logged, either from Outlook items such as email or phone call. 

Modified – The date/time the case was last worked on. 

Created By – The support staff (or agent) take was responsible for logging this case. 

Modified By – The support staff (or agent) take recently modified and updated the case. 

First Response – The date/time the first response to the caller was made (by an agent) after this case was raised. 

Case Age - Shows the duration (in days) the case is active. 

Status - This is a drop-down field that consists of the problem status list (customizable by agents with admin access). 

Priority - This is the same Outlook importance field that takes one of these values - High, Normal and Low. 

Category - A drop-down field that consists of the problem category list. Specify the problem category to which the 

support request belongs to. 

Type - A drop-down field that consists of a type list (sub-category) for each problem category. The type list changes 

depending on the item selected in the problem category drop down field. 

 

Apply default agent - This check button gets enabled when a combination of Category and Type is selected from the 

drop-downs. Clicking this would automatically assign the agent (associated with selected problem) to the current case. 
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 Caller Information of the Case 

These are caller specific fields that are collected from email, address book or global address list. 

Callers List – Choose a caller from the Callers List maintained under AssistMyTeam Helpdesk settings database for this 

case. Manager can maintain a list of callers under AssistMyTeam Helpdesk Manager > Callers List panel. 

 

Pick caller from Global Address List (GAL) - Allows the agent to pick a user from the address book (e.g., global 

address list). For new (empty) support request, an agent can easily pick a contact from the address book (e.g., GAL) and 

that populates any additional caller details automatically. 

 

The email address of the caller - This drop-down field houses all the email address of the callers defined in the Callers 

list manager. This is useful when the agent had to manually log a new support request case, say when caller is on the 

phone. Selecting an email address automatically populates other fields such as caller name, address, phone etc.; thereby 

reducing time spent trying to log every single detail on the caller. 

Apply default agent - This check button gets enabled when a caller email address is selected from the drop-downs.  

 

Checking this button would automatically assign the default agent (specified for that selected caller) to the current case.   

The full name of the caller - For new (empty) support request, an agent can easily pick a contact from the address 

book (e.g., GAL) and that populates all other caller details automatically. 

The telephone number of the caller - If the caller exists in the AssistMyTeam Helpdesk Callers list, a telephone 

number can be specified and it automatically gets listed in this field. If the caller has been picked from the address book 

(e.g., GAL, AD), this field would also get populated (provided the primary telephone of the picked user is specified in GAL 

or AD). 

The mobile number of the caller - If the caller exists in the AssistMyTeam Helpdesk Callers list, a mobile number can 

be specified and it automatically get listed in this field. If the caller has been picked from the address book (e.g., GAL, 

AD), this field would also get populated (provided the mobile number of the picked user is specified in GAL or AD). 

The full correspondence address of the caller - This field also gets populated automatically when caller is specified 

from the AssistMyTeam Helpdesk Callers list or picked from the address book. 

The organization/company to which the caller works for - This field gets populated automatically when caller 

is specified from the AssistMyTeam Helpdesk Callers list or picked from the address book. 

 

Apply default agent - This checkbox gets enabled when the company field is populated with a value or is selected from 

the drop-downs.  

 

Checking this button would automatically assign the default agent (associated with that company) to the current support 

case.  
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Agents Assignment to Case 

This is where the agent assignment is performed, either by the managers or by the agent themselves. The add-in can also 

be configured to automatically assign agents based on certain criteria such as, if there is a default responsible agent 

associated or linked with the caller, or the chosen problem type, or the domain name of the caller.  

 

 

The agents that are currently assigned to the case. 

 

Select the agents from the list to assign to the case. You can assign multiple agents if needed. 

 

 

Click this to assign yourself to the case. 

 

Remove the selected agents from being assigned to the case. 

 
 Compose and open a new email populated with details on the case using the ‘Email to Agent’ template 

(accessible from Outlook > File > Helpdesk Manager > Templates Manager 

 
 Add/update the due date appointment to the mailbox calendar of the selected agents. If successful, it 

automatically triggers a reminder popup to those agents as well as get added to Outlook today page. 

 
 Add/update the support request task to the mailbox task folder of the selected agents. If successful, it 

automatically triggers a reminder popup to those agent as well as get added to Outlook today page. 

 

NOTE: Typically, a manager or senior technician assigns the best agents to the case for fulfillment of the service and 

speedy resolution. Furthermore, in the helpdesk settings, administrator can link and associate an agent to a caller, or to a 

problem type such that when a new support request email is received, if there is a match between agent and the caller 

(read as sender), or if a problem type is found in the email subject, the associated agent will get assigned automatically to 

the case. 

Assigned agents then get notified through an automated email. Optionally, the due date of the case is entered into the 

personal calendar of the agent’s mailbox. 
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Response and Due time assignment of the Case 

When due and response time is enforced on a case, the add-in makes sure the deadlines are properly followed or else, it 

would trigger automated alerts to the assigned agents.  

 

 

Respond by date - duration within which the assigned agents of the case should have responded to the caller for the 

first time (after the case was logged).  

The manager can set an initial response time by manually specifying one after the case was raised, or a default date/time 

could be set under AssistMyTeam Helpdesk Manager > Case Options > New Case tab. 

 reset the respond by date to none. 

 

Due Date - The due date field enables helpdesk manager to set a time before which the case should be resolved. There 

are lot of automatic notifications and reminders options that can be sent to assigned agents when a new due date is 

specified or updated. For example, when a new agent is assigned, AssistMyTeam Helpdesk sends out notification email 

informing agent on the due date of their cases. It can also automatically add/update a due date appointment or task to 

the personal mailbox of the assigned agent so that Outlook handles the reminders to the agent. 

 reset the due date to none. 

 

 
Duration Messages of the Case 

These are measured intervals that are calculated based on the difference between two helpdesk date-time dimensions. 

Response Duration - The time taken by the assigned agent to respond to the caller for the first time once the case was 

raised. 

Open Duration - For an ongoing case, it is the interval between the case creation time and the present time. 

For a resolved case, it is the interval between the case creation time and case closure time. 

Raise Duration - It is the duration between the email received time and the case creation time. In other words, this is the 

time taken by the agent to raise a case from an email once it is received in the Inbox. 

Breach Duration – It is the duration that is left to resolve the case before it is due. 
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Custom Fields of the Case 

If your helpdesk requires to collect more in-house information on the case, manager can add any number of additional 

fields from AssistMyTeam Helpdesk Manager Add-in > Custom Fields panel. Supported data types for the custom fields 

are: Text, Number, Currency, Yes/No, Date/Time, Note or drop-down List. 

All the deployed custom fields would be then available in the case form for input. Data collected from custom fields are 

available for use in Reports Generator and statistics. 

 
 

 
Reply to Caller of the Case 

Compose and send a reply email to the caller of the selected case. There are 3 different types of reply that can be made 

to the caller. 

 

 

  Make a reply to the caller by including all the past conversations on the case, including embedded/inline images. 

The add-in will automatically build the reply email with subject deriving from the case subject and salutation (e.g., Hi 

CALLER) embedded on the top most part of the body, and preceded by 2 empty line breaks which is where the agent can 

type in the response. And the bottom section in the body is that of the past conversations of the case. 

 

 

 Make a reply to the caller with no past conversations i.e., with only simple salutation. The subject of the reply will 

be derived from the case subject and the add-in will make sure; the case number ID is present in it for tracking purpose. 

 Make a reply to the caller using a customized email template. This template ‘Reply to Caller’ can be accessed 

from Outlook > Helpdesk Manager > Templates Manager.  
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Reply to Caller of the case with a KB article 

Choose a KB article and embed it to a reply email to the caller. There are two different ways you can make a reply to case 

with a chosen KB article. 

 

 Make a reply to the caller with a KB article and include all the past conversations on the case, including 

embedded/inline images. The add-in will automatically build the reply email with subject deriving from the case subject 

and salutation (e.g., Hi CALLER) embedded on the top most part of the body, and preceded by the chosen KB article. And 

the bottom section in the body is that of the past conversations of the case. 

 

 Make a reply to the caller with a KB article with no past conversations of the case i.e., with only simple salutation. 

The subject of the reply will be derived from the case subject and the add-in will make sure; the case number ID is 

present in it for tracking purpose. 

 

 
Disable Case Alerts to Caller and Agents 

These options allow for selective disabling of auto alerts that are available for sending to callers or agents. Sometimes, on 

specific cases or caller or assigned agents, you may want AssistMyTeam Helpdesk not to send auto notifications on the 

activities or events of the case. So instead of disabling a particular auto-alert at the global level, you can choose to disable 

auto-alerts on per case. Just check the options 'Disable Notifications to Caller' or 'Disable Notifications to Agents’. 

You can also set AssistMyTeam Helpdesk to automatically check both these options on newly raised cases from 

AssistMyTeam Helpdesk Manager > Case Options > New Case tab. 
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Edit Conversations of the Case 

Enable 'edit mode' for the consolidated conversations field. That is, if this is enabled, it will allow the agent to make 

changes to the existing conversations or add new content manually. This will also force Outlook to make the formatting, 

insert attachments options available in the toolbar. By default, the conversations box is locked. 

 
 

 
Mark Case as Complete 

If the selected case is ongoing and once it is resolved, you can click this button to mark it complete. Email notification to 

the caller about case being closed may follow automatically, if enabled. 

 

 
Save Case to DB 

Press this to save the changes made to the case such as change in the metadata fields, or drop downs or the 

conversations. This will then be saved to the database. 

 

 
Remove Case from DB 

Permanently remove the current case from the Helpdesk database. You will be prompted with a confirmation. 

WARNING: This action is irreversible and so be very sure what you are removing. 

 

 
Save Case as Draft 

Press this to save the current opened case as a draft item your Outlook, so that you can edit it again later on without 

actually committing the changes to the helpdesk database. This may come handy in situation where you are waiting for 

more inputs from the caller, or you are typing in a long description of the problem and you only want to commit to save 

the changes to the database when you are fully ready. 

At any time, you can click ‘Save to DB’ button to commit the changes back to the helpdesk database. 

 

 
Make KB from the Case 

If the current case contains any useful information that helps in solving a commonly recurring problem, you can use it as 

a source to create a new KB article in the helpdesk for future use. In fact, any support case is eligible to become flagged 

as a KB Article. An agent recognizing a repetitive support issue, can easily flag a resolved case as a knowledge article. 

Thus, it acts as an effective knowledge sharing medium, boosting support productivity by leveraging collective knowledge 

and providing invaluable KB Articles to support techs in a snap! It also helps in improving the average ‘First Call 

Resolution’ timing significantly, as agents find resolution to problems quickly.  
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To learn more, refer to the ‘Creating a new KB article’ section. 

 

 
Export to file 
 

Export the current case to PDF document file. You can also export to Word Documents, HTML, plain text etc. 

 

 
 

You can control what case data are included in the files by customizing the 'Print' template under AssistMyTeam Helpdesk 

Manager > Templates Manager. For example, place the variable 'CASE_BODY' in the Print template such that the 

exported file (e.g., pdf) contains all the consolidated conversations (body) from the case item including inline images. 

 

 
Print Case 

Click this to print the current case using the 'Print' template (as defined under AssistMyTeam Helpdesk Manager > 

Templates Manager). This will show you the print dialog option, where you can customize the layout, paper size etc.  

 

 
Discard and Exit Case 

Press this to cancel any changes made to the case and close the case window from Outlook, without committing any 

changes to the helpdesk database. 

 

 
Forward case 

Forward the selected case to a recipient or stakeholder. 

 

 
Form Orientation 

Change the orientation or placement of the case form in either left or right side of the conversations box of the inspector 

window of the opened case. 

  
 

 
Subject of the Case 

The subject of the case. You can customize it to make the problem quite obvious at first glance. 
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Case Conversations 

Most cases cannot be closed within a single e-mail and response. Feedback from the caller and suggestions from other 

stakeholders often occur over multiple request-response emails. Moreover, different members from the support teams 

may provide resolutions during the course of the case. In a practical scenario, a case might have various e-mail versions of 

the resolution steps, making it cumbersome to get a complete picture of responses and resolution.  

In this case conversations box, the helpdesk add-in captures the complete course of the conversations chronologically, 

from all email communications received or sent (including those automated notifications sent to caller and agents in due 

course). The end result is a consolidated view where all the responses and replies are collated together. Redundant and 

repeated conversations are filtered out to present only the relevant communications.  

 

This eases the task of the helpdesk and minimizes repeating what has already been done, while keeping support team 

members to stay on the track. Another advantage is it allows the agents and managers to quickly glimpse through the 

conversations and get a complete overview on the responses in chronological order and resolution applied to the case. 

This is hardly possible if you were to refer to multiple email responses and on top of it, the efforts required to navigate 

multiple Inboxes and Sent Items and scan for the right emails. 
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7.2 Time Spent on Case 
 

The Time Spent section lists all work sessions performed on the case by the agents and managers. This time spent field can be made 

optional or mandatory before marking the case as closed. By default, it is optional. Also, to calculate cost for billing purpose in 

reporting and statistic tools, Helpdesk needs to have a valid work time from the assigned agents. 

 

 

List of all time spent entries made by agents assigned to the case when working to resolve it. Apart from the time spent 

value (either in minutes or hours), each record in the list shows the agent’s name who made the entry, the date and time 

etc. 

 
Shows the total time spent (either in minutes or hours) made so far on this particular case. 

 
Enter a new time spent value to the case. A pop-up dialog allows you to enter a duration (in minutes or hours), as well as 

description of the work done.  

 

 

You can also enter a start and end time so that the duration is automatically calculated. 
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Edit an existing time spent entry. You can also modify the time spent value and description. The agent and time stamp 

are however, read-only. 

 

 
Remove the selected time spent entries from the case.  

 

NOTE: you need to save the case in order for the removed entries to be permanently reflected to the case. 
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7.3 Add Notes to Case 
 

The notes section enables the agents and managers to add private notes to the case for internal use. 

 

 

Enter the new note that you would like to add to this case. 

 
Click to add the new note to the existing notes of this case. Each note that is added to the case bears a 

header title that has the agent’s name and the date and time the note was added. 

 
Existing notes of this case. Each note is separated by an empty line. 
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7.4 Related Cases 
 

The ‘Related Cases’ tab lists all the ongoing and resolved cases logged for that particular caller, or company or email domain so the 

responsible agents can have a panoramic view of all past problems history.  

 

 

Choose a filter (caller, company or domain name) that will be used to search for matching cases. 

 
Open the selected case in its own case form (e.g., inspector window). Alternatively, you can double-click 

the case entry to open it. 

 
Merge the selected case with the current case. Sometimes, a caller might contact you through separate 

emails or channels regarding a particular issue. The same issue might be logged as a case by a different 

agent not knowing an existing one already exists. To avoid duplication and conflicts, you can such cases 

into one and keep the communication streamlined. 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case. 
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8. Raise a new empty Case 
Sometimes you might need to raise new case based on the issue reported by your caller through phone calls. In such situation, you 

can press the ‘New Case’ button located in the helpdesk toolbar to raise a new empty case and feed the information including the 

issue description into the form. 

 

Within the empty case form, the first step you typically would like to start is by entering a short summary in the subject to enable for 

quick identification and then describe the issue in detail in the body field. You can insert supporting files as attachments (similar to 

how you attach a file when composing an email in Outlook). 

 

 
Enter a brief summary of the issue reported by the caller on the phone in the subject field. 

 
Enter detail description of the issue on the body field. 

 
Feed the caller’s name, email address, phone number, company etc. into the caller information section of the case form. 

Once the required details are entered into the form, click the ‘Save to DB’ button to generate and assign a new ID to the case. You 

can then provide this ID to your caller on the phone. Additionally, the add-in will also automatically send a confirmation email alert 

to the caller. 
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9. Raise a new case from an email manually 
Support cases can be generated from diverse source such as incoming emails, appointments, tasks or phone calls and are available 

instantly to all members of the helpdesk team in Outlook.  

9.1 Convert email, appointment or task item to a case 
 

In your Inbox or calendar or task folder, select that particular email, appointment or task item and press 'Convert to case' located in 

the helpdesk toolbar to raise a new support case.  

  

You can then add further details (such as the classification of problems the request falls into) to the case form. 
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9.2 Raising a new case after sending the initial lead/contact to the caller 
 

Sometimes, the helpdesk team may need to initiate or start a case without a request received directly from a user. For example, you 

send a user the serial number for a software they have purchased not because of a request they sent in. So, typically, in such 

scenario, you are initiating the communication by sending them an e-mail that says “Your key is xxxxxxx and here is a link to the 

software”. At the same time, you want a case to be opened based on that email sent to them. 

To accomplish this, a check option 'New Case' is provided in the compose window of the email. So, when you check this option, and 

press 'Send' button, the email will be sent successfully to the caller/contact. At the same time, AssistMyTeam Helpdesk will raise a 

new case based on that email, with populating the caller details and the description of the problem/email. 

 

A new case is raised based on that email sent to the caller/contact. 
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10. Add an email to a case 
If you want to add an email to an existing case, click ‘Add to existing case’ button available in the helpdesk toolbar in your Inbox. 

This is useful if the caller emails the helpdesk multiple times on different threads but on the same issue or case. You can manually 

add such related emails to an existing case in a click. 

 
 

'Add to Existing case' is available in two variants:  

 

 

Through Search - The selected emails will be added to the chosen case in the search panel. If you don't know the case ID 

to which you want to update the emails to, use this method to search for cases that meet certain criteria and from which 

you can choose one quickly. 

 

 
Through ID - If you already know the Case ID to add the selected emails, you can enter it to update quickly. 
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11. Add replies to associated case 
If the emails from the caller already have a case ID embedded in the subject, you can press ‘Add to Case #’ button and the add-in will 

accordingly update the case with no further input required from you.  

 

Instead of manually updating the case with replies to existing case from callers, you can automate this process so that the agent add-

in will selectively monitor incoming emails and only process those replies that have embedded case ID in the subject and 

subsequently updates the associated cases. You can enable this automation from Outlook > AssistMyTeam Helpdesk toolbar > 

Settings > Personal Settings > Email Tracking – Incoming tab. 

 

 
By default, the add-in only tracks and processes the emails associated with existing cases from your primary mailbox. However, if 

you receive emails from callers to other mailboxes in your Outlook, then you must specify those mailboxes too. Enabling this would 

force your AssistMyTeam Helpdesk Agent add-in to look for incoming/outgoing emails in those mailboxes too. 
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12. Remove link to case from an email 
This button will be visible when you select any email that has a case ID (with or without Prefix code) in the subject. Clicking it will 

remove the references of the case from that email. You can then raise a new case from that email. 
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13. Automatic Case logging in Inboxes 
Many organizations believe e-mail is a highly efficient way to have their customers submit service and support requests. Your 

customer writes in the problem, presses send, and within seconds, it is in support mailbox of your helpdesk account. But the reality 

is that nothing happens until someone reads it, creates a case from it (this usually involves cutting and pasting from the e-mail), and 

assigns it to an engineer or agent for resolution. Because there is both manual labor and personal attention involved, the process 

can result in delays, support requests falling into the cracks, errors in transcription, and unhappy clients. And unfortunately, this can 

become a barrier in the helpdesk main goal, which is to provide timely response to the caller. This is a nightmare scenario for 

helpdesk team. 

Fortunately, this is easily avoided in AssistMyTeam Helpdesk. As it is integrated seamlessly with your Outlook email client, there is 

no requirement to cut and paste information from the email to the support case. Even better, there is no need to manually process 

each email. You can configure your helpdesk add-in to monitor any number of mailboxes and email folders in your Outlook such that 

it can intercept incoming emails and automatically generate cases out of the emails, all instantly i.e., as and when emails hit the 

inbox. With this kind of setup, you are freed from having to monitor inboxes manually every now and then. 

Additionally, you can extend your helpdesk to even assign default agents to newly logged cases on the fly, based on the linked 

relationship between agents and the prefilled fields such as sender, domain name or problem type. This automates the case logging 

and assignment entirely on its own. The generated cases are then stored in the helpdesk database making them available to all 

members of your team for collaboration. Any file attachments from the original emails will be automatically attached to the case; 

making distribution of inbound requests simple and informative. This way, all support submissions are captured and centralized in 

order to execute efficient and effective customer service. 

 

 

Choose an Inbox or email folder (such as an Exchange folder or Public Folder) that will be monitored by the helpdesk 

add-in to and raise new cases from incoming emails automatically.  
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A ‘Select Folder’ dialog box allows you to choose the Inbox folder from your Outlook. And then click OK. Now click 

‘Confirm and Add’ to the monitored list. 

 
Click this to customize the metadata for the automation, such as specifying a default category, type, agents - new cases 

will take.  

 

Lastly, you can enable or disable the case automation state for the particular mailbox account or email folder. You may 

want to disable the automation process temporarily on a particular mailbox or folder if for instance, a maintenance or 

migration is planned. 

 

 
Click this to activate all chosen Inbox folders for automation. 

 
Click this to de-activate automation from all the chosen Inbox folders. 

 
Remove the selected Inbox folder from the automation list. 

 
Remove all Inbox folders from the automation list. 
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14. Knowledge Base 
The inbuilt knowledge base in Helpdesk allows agents to document best practices and solutions to common problems so that they 

can be used when replying to time-consuming and repeated queries. Any support case is eligible to become flagged as a KB Article.  

An agent recognizing a repetitive support issue, can easily flag a resolved case as a knowledge article. Thus, it acts as an effective 

knowledge sharing medium, boosting support productivity by leveraging collective knowledge and providing invaluable KB Articles to 

support techs in a snap! It also helps in improving the average "First Call Resolution" timing significantly, as technicians find 

resolution to problems quickly.  

 

 

 

14.1 Understanding the Article form in Outlook 
 

It is very easy to use the knowledge base in Outlook. A Question-and-Answer format is used to intuitively display Knowledge Base 

Articles. Each Article may have any number of file attachments associated, rich-text elements, and hyperlinks to other web pages. All 

articles are tagged with a related problem category and problem type, so it is easy to find a particular resolution at time of needs. 

 

 
KB ID 

The unique ID that is identifies the KB article in the helpdesk database. 

 

 
Created On 

Displays the date and time the knowledge base item was created.  
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Modified 

Displays the date and time the knowledge base item was last modified. 

 

 
Category 

Drop down list of all available problem categories defined in AssistMyTeam Helpdesk problems list. You can select a value 

from the list to mark the category to which the current knowledge base item belongs to. 

 

 
Type 

Drop down list of all available problem types (sub-categories) of the selected problem category. When you select from 

the problem category drop down, another tier of problem type lists will be loaded in the type drop-down control. These 

nested tiers of categories/types are complete customizable to your organization's business model and act as somewhat 

of a guiding decision tree when you search for a particular knowledge base article. 

 
Private 

Check this option to set the KB article as 'private'. Private KB articles can be set to not publish to the online KB module of 

Customer Web Service (CWS) site. Further, you can also set AssistMyTeam Helpdesk to hide the private KB articles from 

showing up in the 'Reply with a KB' dialog panel. You can control these options from 'AssistMyTeam Helpdesk Manager 

Add-in > Advanced Options > KB' tab. 

 

 
Edit Answer 

Click this button to edit/revise the description content of the knowledge base. By default, once a knowledge base article 

is created, subsequent accessing displays the KB in read-only mode. 

 

 
Forward 

Click this button to forward the current knowledge base item (including attachments) to a contact. 

 

 
Save to DB 

Click this button to save any changes made to the current knowledge base and close the inspector window. 

 

 
Remove from DB 

Remove the article permanently from the helpdesk database. You will be prompted with a confirmation. WARNING: This 

action is irreversible and so be very sure what you are removing. 

 

 
Save Article as Draft 

Press this to save the current opened article as a draft item your Outlook, so that you can edit it again later on without 

actually committing the changes to the helpdesk database. This may come handy in situation where you are waiting for 

more inputs, or you are typing in a long description of the problem and you only want to commit to save the changes to 

the database when you are fully ready. 

At any time, you can click ‘Save to DB’ button to commit the changes back to the helpdesk database. 

 

 
Discard and Exit Article 

Press this to cancel any changes made to the article and close the article window from Outlook, without committing any 

changes to the helpdesk database. 
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Export to file 
 

Export the current article to PDF document file. You can also export to Word Documents, HTML, plain text etc. 

 

 
 

 
Form Orientation 

Change the orientation or placement of the article form in either left or right side of the conversations box of the 

inspector window of the opened case. 

  

 

 
Article Subject (or Question) 

The subject (or a question or a summary) of the current knowledge base. 

 

 
Article Description (or Answer) 

The description field of knowledge base item. A Question-and-Answer format is ideally suited to intuitively display KB 

article. It may have any number of file attachments, HTML formatting, and hyperlinks to other web pages etc. You can 

use the default Outlook formatting tools (such as bold, font, fore color etc.) on this field. 
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14.2 Creating a new Knowledge Base Article 
 

An empty knowledge base can be created directly from the dashboard, in which case, it would have to be fed manually. A knowledge 

base can also be generated from an existing Outlook item such as email, task or appointment. Generated knowledge base item will 

then inherit the email body (and its format) as well as any number of attachments. Agents or helpdesk managers would then tag 

with a problem category and one of the types available for that selected category. 

There are many ways to create a KB article and store it in the helpdesk database.  

Creating new article from Dashboard 
 

To create an empty KB article from scratch, click ‘New Article’ from the menu you get under ‘+’ in the helpdesk dashboard of 

Outlook. 

 

Alternatively, you can also click ‘New Article’ button located in the Articles section of the dashboard. 

 

Creating new article from Inbox from an existing email 
 

If an email contains useful information that helps in solving a problem, you can use it as a source to create a new KB article in the 

helpdesk for future use. From your Inbox folder, select that email and click ‘Create KB’. 
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Creating a KB article from a resolved case 
 

If the current case contains any useful information that helps in solving a commonly recurring problem, you can use it as a source to 

create a new KB article in the helpdesk for future use. In fact, any support case is eligible to become flagged as a KB Article. An 

agent recognizing a repetitive support issue, can easily flag a resolved case as a knowledge article. Thus, it acts as an effective 

knowledge sharing medium, boosting support productivity by leveraging collective knowledge and providing invaluable KB Articles 

to support techs in a snap! It also helps in improving the average ‘First Call Resolution’ timing significantly, as agents find resolution 

to problems quickly.  
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14.3 How to use the knowledge base articles in Outlook 
 

A knowledge base solution can be used for replying to emails, support case or for embedding into an appointment/task or for simply 

forwarding it to an Outlook contact. A dialog window allows the agents to browse through the existing knowledge base items, even 

preview it before it can be chosen for embedding into the particular Outlook item (email, appointment, task, support case etc.) 

Steps to embed a knowledge base to a new email, appointment, task or a support case. 

Select a particular outlook item (email in the screenshot below) and click the 'Reply with a KB' button to display the KB selection 

dialog. 

 

 

A pop-up dialog box allows you to browse through the existing knowledge base articles, and select the relevant article to be 

embedded either as Word, PDF or XPS attachment or as inline content into the email reply. 

 

Browse through the listed KBs by problem type and category. Click a KB subject from the tree view to preview the content. Finally, 

when you have found the appropriate knowledge base item, select 'Insert'.  
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The listing of all non-private KB articles available for references. KB articles are presented in tree-view layout with 

problem categories as parent nodes and problem types as child nodes. And KB articles are then shown, grouped by 

category and type.  

 
The preview pane - Choose a KB article and click to preview its content in the preview pane located below or right 

(depending on the chosen layout). 

 
If you have hundreds and thousands of KB articles, finding the relevant and right articles could be tricky. For ease, you 

can search the KB articles with a keyword to find all matching KB articles that contain the keywords. KB articles that 

match the search will have light red background color for easy reference.  

 

 
Place the preview pane of the chosen KB article to the right (side by side layout) 

 
Place the preview pane of the chosen KB article to the bottom (top to bottom layout) 

 
You can embed the selected KB article directly into the body of the email reply. Any inline images and formatting are 

preserved in its original state in the reply also. 

 

You can also choose to insert as attachment in the form of a word document (*.doc), Adobe PDF (*.pdf), Microsoft XPS 

(*.xps) or as single file MHTML (*.mht). 

 

Additionally, you can also customize the attachment name of the PDF or Word document such as naming the attached KB 

article file with the ID of the KB, or with the subject summary or a combination of both. 
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Check this option to directly send out the reply to the recipient without showing the compose window of the reply. 

 
Once a KB article is found that resolves the issue as reported by the caller, choose it from the tree structure and click 

‘Insert’ to continue. 
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15. Personal Settings 
The personal settings, as the name suggest, are each agent’s settings that are applied to AssistMyTeam Helpdesk System locally, i.e., 

the change in the personal settings is not affected to the workflow of other agents. The personal settings differ from other 

administrative settings in that it is saved locally to the system's registry, whereas other administrative settings are saved on the 

database. 

15.1 General Section 

 

 

 
Refresh Dashboard  

You can specify the interval (in minutes or hours) to refresh the listing of cases and articles automatically in your 

dashboards. This make sure agents are looking at the information in the dashboard from the most current state of 

the helpdesk data. Instead of having to run a number of queries, the add-in runs these searches automatically, 

making sure that you are never looking at stale data. You won't have to remember to run important searches once 

you have selected the parameters in the dashboard - you'll be able to spend your time gaining insight into your 

assigned cases as well as overall state of your helpdesk. 

 
My default time duration 

You can specify your own default time duration that will be used selected by default when you add new time spent entry 

in the case.  

 
Disable balloon popup notification 

Enable this option to prevent the popup notifications to show up (in the right most corner of the screen) when there is a 

new event in the helpdesk. 

 
Show helpdesk context menu on top 

Enable this option to show the helpdesk context menu in topmost position when you right-click any case or email items in 

Outlook. By default, the helpdesk menus are shown in bottom position. When this option is enabled, the helpdesk menu 

items appear at higher position in the context menu (right-click menu). 
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If the option is unchecked, the helpdesk menu items appear at the lowest position in the context menu. 

 

 
 

 
Changing the UI Language 

Choose a language that will be used in all the AssistMyTeam Helpdesk UI in Outlook. The following languages are 

supported:  

English, Español, Norwegian, Danish, Dutch, Deutsch, French, Finnish, Swedish, Portuguese 

NOTE: When you switch to any language and save it, the chosen language will be applied to the next session of Outlook. 

Therefore, you are required to restart your Outlook for the new language to be affected to all forms, panels and UI of the 

add-in in Outlook. 

 

 
Overwrite path to OLAP Cube 
 

If the ‘My Documents’ of your workstation is mapped or set to a network path folder, you cannot run OLAP 

statistics from your Outlook. In such case, you can specify a local folder explicitly for use for OLAP reporting. 
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15.2 Automatic Email Tracking Section 

 

 
 

 

Automatically track incoming replies and update the associated Support case 

 

Enable this option for the incoming replies from callers to be automatically added and updated to the corresponding case. 

The agent add-in will then track and monitor the chosen mailboxes for any incoming emails that are related to existing 

cases. And if one is found, it will be automatically added and updated to its corresponding case item. 

By default, the helpdesk Agent add-in tracks and processes the emails associated with existing cases from all your 

mailboxes. So, you don’t need to manually enable them unless you had disabled them before. If other mailboxes won’t 

receive any responses from your callers, you can uncheck the corresponding Inboxes and disable the automatic tracking 

feature on those mailboxes.  

 
Automatically track outgoing replies and update the associated Support case 

 

Enable this option so that responses to the caller from the helpdesk are automatically added and updated to the 

corresponding case. By default, the agent add-in monitors all the sent items folders of your mailboxes for outgoing emails, 

so you don’t have to manually check and enable them unless you had disabled them before. 
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16. Helpdesk Summary Reports  
Helpdesk summary reports play a vital role in keeping informed managers about recent cases - that were created, worked, 

overdue or resolved. AssistMyTeam Helpdesk provides an inbuilt tool that generates reports on support cases based on a 

specified interval such as today, this week, this month, last month etc. Any fields can be selected for inclusion into the reports 

and can be saved as to file or printed for sharing and easy distribution. 

 

 
Each case in the search result is color coded to reflect the current status of the case. You can easily recognize which cases 

require the attention or review, and plan actions accordingly. 

 

 

 

Time Period: Choose a time period from the followings under which the search will be confined: 

Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This 

Year, Last Year, Date Range, On 

 

The option 'Date Range…' allows for user selection of start and end date. 

 
 

 

 
 

Report Type: Choose a report type from the predefined ones below: 

Any, Cases Created, Cases Resolved, Cases Ongoing, Cases Worked, Cases Due, Cases Response Date, Cases 

unassigned, Cases lapsed - Due Time, Cases lapsed - Response Time, Cases with no Due Date, Cases with no 

Response Date, Cases with no Caller 

 

 
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields: 

Status, Problem, Caller, Company, Priority, or Author. 
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Group By: You can choose to group the cases either with:  Agents, Status, Problem Category, Problem Type, Caller, 

Company, Priority or Author. 

 

 
Fields: For finer control over the output of 

report, you can choose which fields (including 

custom fields and calculated fields) are to be 

included in the report.  

You can sort the items by clicking at the column 

headers, as well as also re-arrange the columns 

in the list view according to certain sequence of 

your choice, and even set the width of the 

columns. These formatting from the List view 

panel will be inherited on other tabs - HTML, 

editable HTML and Grids. 

The tool will remember your choice in 

subsequent runs. You can re-arrange the 

columns by drag-and-drop to get the kind of 

view you want. And the display order of the 

columns will be retained in subsequent 

sessions. 

 

 
 

Some useful calculated fields that you can include in the report: 

• Raise Duration - interval between when the support request (email or phone call) was received and when 

the case was raised. 

• Response Duration - interval between when the support request was received (email or phone call) and 

when the first response was made to the caller (by an agent) 

• Open Duration - interval between when the case was raised and the current time. 

• Resolution Duration - interval between when the case was raised and when it was closed/completed. 

• Breach Duration - interval between when the case was due and when it was actually closed/completed. 

 

 
Scope: Choose if to confine the search to your assigned cases only or include all cases. 

 

 
Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used 

by Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as 

there are multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current 

mode (tab) that you are in. 

 

 
Save the current report to file – Once you get the look and feel of your report, you can then export the report to 

one of the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe 

PDF, Rich Text or web page etc. 
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List report view mode – This act like a template to the other three report modes. For finer control over the output 

of report, you can choose which fields (including custom fields) are to be included in the report. You can sort the 

cases by clicking at the column headers, as well as also re-arrange the columns in the list view according to certain 

sequence of your choice, and even set the width of the columns. These formatting from the List view panel will be 

inherited on other tabs - HTML, editable HTML and Grids.  
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17. Helpdesk OLAP Statistics and Reporting 
With the integrated Online Line Analytical Processing (OLAP) tool, helpdesk managers can analyze the support request data in 

multidimensional view and extract mission critical information and intelligence that will enable better decision- in your 

helpdesk and organization. The tool supports the ability to explore large complex data sets and allows displaying in grids, 

charts and graphs and support most common operations such as pivoting, drill down/slice and dice, filtering etc. With such 

arrays of information, the organization can reengineer their help desk processes, reinforce resources and forecast problem 

areas and exploit all these factors for competitive advantage. 

 

Why OLAP?  
Real strength of OLAP is its ability to examine and view data in ways not ordinarily possible. By allowing varying levels of 

granularity during data inspection and visualization a lot of information can be revealed that would otherwise be hard to 

attain. Given that most business models are constrained by more than three dimensions, it is hard to fully evaluate a business 

without the ability to inspect each dimension in detail while preserving context eliminating all guesswork. OLAP is perfectly 

suited for this purpose. Now it’s easier than ever to spot new trends and discover unknown problems in your data flow. The 

statistical tool will help you gain an insight into your data and make new discoveries. Comes with various inbuilt reports 

specific to AssistMyTeam Helpdesk Cases. 

 

Reporting made easier 
The statistical tool's simplistic point-and-click interface will ensure managers easily achieve the high-level views of information 

they require. Additionally, the OLAP client makes creating reports destined for different management levels a simple task - 

eliminating managers' dependence on IT personnel. By unifying data analysis needs on a single platform, it provides an 

unparalleled array of reporting tools for web portals, intranet applications, websites, and other data-rich applications. 

 

Printing capabilities 

You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer 

settings before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide 

range of formats including PDF, XLS, CSV, JPG, etc. 

 

Copy to Clipboard 
Select any data range in Chart/Grid and copy to clipboard. Then you’ll be able to paste it in an Office program for further 

analysis. You can also paste the chart like a picture to illustrate your investigations. This greatly simplifies the task of creating 

detailed, data-rich documents. 

 

Save Reports in file 
At any stage, managers/agents can save the report and distribute it to another person for analysis by network or email, so 

when the recipient gets the file, he or she can open it and see the same OLAP slice. 

 

Launching the statistics tool 
 

Go to Outlook > AssistMyTeam Helpdesk toolbar and click ‘My Statistics’. 
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You can choose what type of OLAP statistics on helpdesk data you would like to see and report on. You can specify if the 

statistics would be confined to ongoing cases or resolved cases or on both. 

 

 
 

There are two parts of OLAP Statistics 

 

 

General OLAP 

Choose this OLAP to run statistics on cases with all helpdesk parameters and fields except for time spent by agents 

on cases. 

 

 

Time Spent OLAP 

Choose this OLAP to run statistics on time spent entries by agents on cases. 
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17.1 The User Interface 

 
The statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the Working 

area. The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can 

set the panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with 

the mouse. At that, all the possible locations, where it can be dropped to, will be highlighted. You can detach a panel from the 

component; it will be displayed as a float window. 

 

 
 

Instrumental panels can be: 

• Attached to any side of the component;  

• Placed into any existing panel;  

• Displayed as bookmarks on any panel;  

• Set as auto-hidden panels;  

• Used as float windows. 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When you start 

dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most elements have context 

menus that duplicate the mouse actions and provide additional control functions for managing the slices' view. 

 

 

The File menu 

The file menu consists of the following commands: 
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a) Open Offline Cube from file - While generating a live cube from Outlook always provides the advantage of 

analyzing live data, often, you might be away or disconnected from the network. 
 
In such scenario, you have the option of connecting to an offline cube, which was previously generated and 
saved to your local folder using this utility. An offline cube file has the extension - .offlinecube and can be 
either in compressed or uncompressed format. An offline cube gives the same functionality as that of a live 
cube (which is generated from the Outlook data at real time), except that the data in the offline cube is only 
current to the time the cube was saved to file. This provides the flexibility to continue analyzing the cube 
and writing reports etc, while you are on the move. 
 

b) Open a Predefined View - Pre-defined reports are available under Cases, Callers, Date/Time, Problems, and 
Agents nodes. Clicking one of child node report loads the statistical analysis of that report, the resultant of 
which will be displayed in the Grid or Chart (depending on the current active view). 
 

 
 

c) Load report file from Favorite – You can customize or create your own views and save them to the favorite. 
Once saved, your views would be saved under the ‘C:\Users\USERNAME\Documents\AssistMyTeam 
Helpdesk Reports\Views’ folder (in windows Vista and 7). For windows XP, it should under My Documents. 
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When you open the favorite from this menu, you can choose to load your saved view. 
 

 
 

d) Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to save it 
for future reference or share it among your team members. A report view is the current state of the 
statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and Column 
areas) and measure fields in the values area. It has a file extension ‘.olapreport’. 
 

 
 

e) Save report view to favorite – You can save the current view of the statistics (grid or chart) to the favorite, 
by specifying a name of the view. 
 

 
 

f) Save report view as - If you want to share a report view with others, you can simply save the current report 
(state of the statistics along with the pivot details) to a file folder of your choice - could be a network folder 
also. 
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g) Save to offline Cube – Once you have loaded a live cube from the cases, you have the option to save the 
entire cube data to a file (with the extension - .offlinecube) for offline use, when you are disconnected from 
the network. Offline cube can be saved in compressed or uncompressed format, the former option will 
enable you to reduce the file size considerably. 
 

h) Same as e. (above) 
 

i) Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for loading 
another cube. 
 

 

View Menu 

Contains actions that you can perform on the current report view. 

 
 

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of the 
chart/grid. This is useful if you want to start over on a new report view. 
 

b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between the Grid and the 
chart. It is particularly useful, for example, when you have built up a grid with aggregated data, but want a more 
visual representation of the statistics in form of graphs and bars. Also note that, the synchronization will be 
done to the other part (grid or chart) based on the current interface.  
 
For example, if you are in the grid view, and if you pressed ‘Synchronize Chart/Grid’ it would read the state of the 
Grid view and impart the same state (same members and measures) to the Chart view and vice versa. Each of 
the Grid and Chart view can be worked independently as long as you don’t press this synchronize option. 
 

 

OLAP Grid panel 

The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and 

display data according to the hierarchies used to define the measures and dimensions upon which the underlying 

data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level 

of complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data 

to the user. 

 

 

 

OLAP Chart panel 
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While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically. 

This gives managers and members a unique opportunity to analyze their project data visually, dealing with charts 

rather than numbers, which is much easier to perceive. 

 

 
 

 

Cube structure panel 

The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set, 

displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies. 

 

 

 - Measure 

 - Dimension 

 - Attribute hierarchy 

 - Multilevel hierarchy 

 

To select a measure for display you need to drag-n-drop it to 

the Measures panel or the data area.  

 

To select a hierarchy for display – drag-n-drop it to the 

hierarchy area or the pivot panel (rows or columns area). 

 

• Measures are grouped in the Measures category. 

• Hierarchies are sorted into folders - dimensions. If there's 
only one dimension in a hierarchy, it will be displayed in the 
tree root. 

 

Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an 

option to place the element where you like. You can also filter the selected element (see Filtering hierarchies and 

measures) or place it to the selected panel. 

 

 

Pivoting panels 

A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into 

the pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can 

be dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or 

use the appropriate items from the context menu. 
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Measure panel 

Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel 

components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are 

situated in the main part of the panel. 

 

 
 

You can drag measures from one group to another, or extract measures from groups to delete them. To create a 

new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an 

item to create a new group> panel. 

 

Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of 

the pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a 

chart point and its color. 

 

 

Filter panel 

This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply 

powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant 

data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values 

into a single group, so you only have what you really need. 
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The filtered elements (hierarchies and measures) 

are automatically transferred to the Filter panel. 

To assign a filter, you have to move an element 

to the Filter panel. If the element hasn't been 

filtered the appropriate visual filter editor will be 

shown, similar to the one on the right: 

 

 
 

 In the Filter panel, you can call the Filtered Element Editor individually for each element.  

 
 

 

Working Area 

The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the 

frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts - 

Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes. 

 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When 

you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most 

elements have context menus that duplicate the mouse actions and provide additional control functions for 

managing the slices' view. 

 

Grid working area 

 
 

 

 

 

Chart working area 
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17.2 Working with the OLAP grid  
 

The OLAP Grid view is comprised of a multi-dimensional table with expandable nodes. These nodes group and display data 

according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized. 

In tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is 

highly navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong 

formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can 

easily be ported to spreadsheet applications for report compilation purposes.  

 

Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up 

or drill down on data using powerful built-in menus. One of the greatest benefits this affords is that it allows users to explore, 

navigate and refine data until the desired snapshot is achieved. Once in place this snapshot can then be reflected in a 

complementary chart. This is possible as OLAP operations in Grid view can be synchronized with Chart view. These two data 

views can then be deployed side-by-side or on top of one another. 

 

 Unicode support.  
 Simultaneous display of several different measures in the Grid.  
 Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next 

hierarchy.  
 Saving and restoring the current OLAP-slice.  
 Hierarchy members grouping (including multilevel and parent-child hierarchies).  
 Separate sorting on different hierarchy levels. Possibility to override any sorting method.  
 Ascending or descending sorting based on the cell values in any column of the Grid.  
 Filtering of hierarchy members with or without applying these filters to the OLAP calculations.  
 Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either 

based on their rank or on the Pareto principle.  
 Replacing hierarchy members by drag-n-dropping them within the Grid.  
 Auto sizing of cells depending on their contents.  
 Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats. 

 

Operating the OLAP-slice 

The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current 

OLAP-slice there are the following functions available: 

1. Navigation 
2. Selecting and copying data 
3. Drilling, sorting and moving hierarchy members 
4. Operating context menus 
5. Filtering data 
6. Editing data 
7. Setting the column width 

  

1. Navigation - You can easily navigate the data using the keyboard: 

Button  Action 

Home  Move to the first cell of the row 

End  Move to the last cell of the row 

PageUp  Move one page up 

PageDown  Move one page down 

Ctrl+Home  Move to the top left cell 

Ctlr+End  Move to the bottom right cell 

 

Using the mouse, you can scroll the table up and down. 

Mouse Action Component Action 

Scrolling the mouse wheel Vertical scrolling of the table 

Scrolling the mouse wheel with the Shift button held down Horizontal scrolling of the table 

 2. Selecting and copying data - The data area in the component can be selected like everything else in Windows: 
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• Select all the cells pressing Ctrl+A;  
• Capture the area with the mouse;  
• Change the boundaries of the selected area with direction buttons, holding down the Shift button.  

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons will 
copy the whole OLAP-slice to the clipboard. 
 

3. Drilling, sorting and moving hierarchy members - To 
perform the drilling of the hierarchy members press 
buttons on the Grid cells. If there’s only one drilling 
button in a cell, then, instead of pressing it, you can 
double-click the cell itself. By default, the drilling 
buttons are shown only in the cells under mouse. To see 
all the buttons, press the Ctrl button. The last cells in 
the column area of the hierarchy members allow 
showing the sorting direction. A pointer that indicates 
the descending order of data illustrates it. You can 
manage the sorting modes by single clicking on the cells 
of the specified area: they are changed cyclically 
[descending sorting] -> [ascending sorting] -> [no 

sorting]. 

 

 

4. Operating context menus -The context menu, 
called by right clicking a table cell, partly duplicates 

the OLAP-slice control functions. 
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Hierarchy levels' menu 

The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the hierarchy 
levels’ area: 

Command Function 

Show totals first Show the aggregated cells before all the rest 

Show totals last Show the aggregated cells after all the rest 

Don’t show totals Do not show the aggregated cells 

Default sorting Range hierarchy members by default 

Sort ascending Range the hierarchy members by values from the bottom to the 

top 

Sort descending Range the hierarchy members by values from the top to the 

bottom 

Aggregate all hierarchy 

members 

Aggregate all the hierarchy members (including hidden) 

Aggregate visible members only Aggregate the visible hierarchy members only 

Drill all down\ to the next 

hierarchy 

Drill all down to the next hierarchy 

Drill all down\ to the next level Drill all down to the next level 

Drill all down\ to the same-level 

children 

Drill all down to the same-level children 

Drill all up Collapse all the elements of this level 

Clear filter Remove any applied filters 

Filter on captions Set the filter for measures 

Show empty cells Show the cells with no aggregated values 

Create new group … Create a new group. It will appear at the first level of the 

hierarchy 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

 

Hierarchy members' menu 

 
The view of the context menu of the hierarchy members' area 

 

 

 

Command Function 
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Drill down to the next 

hierarchy 

Open the node up to the next hierarchy in the current area, ignoring 

all the lower levels of the current hierarchy 

Hide this member Hide the member 

Hide all members except 

this 

Hide all the members of the hierarchy, except the selected one 

Hide all members above 

this 

Hide all the members of the hierarchy above the selected one 

Hide all members below 

this 

Hide all the members of the hierarchy below the selected one 

Show only the top Show the top elements of the level. Their number is specified in the 

sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Show only the bottom Show the bottom elements of the level. Their number is specified in 

the sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Filter on captions Set the filter for measures 

Create new group.. Create a new group on the current level 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

The menu for groups of hierarchy members 

 
The context menu that appears above the group cell. 

 

 

 

 

 

Command Function 

Hide this member Hide the selected member 
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Hide all members except this Hide all the hierarchy members except the selected one 

Hide all members above this Hide all the hierarchy members above the selected one 

Hide all members below this Hide all the hierarchy members below the selected one 

Show only the top Show the top elements of the level. Their number is specified 

in the sub-menu. If you specify a percent value there, then the 

picking of members will be such that their total value does not 

exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other 

from the menu. 

Show only the bottom Show the bottom elements of the level. Their number is 

specified in the sub-menu. If you specify a percent value there, 

then the picking of members will be such that their total value 

does not exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other 

from the menu. 

Filter on captions Set the filter for measures 

Create new group Create a new group 

Delete this group Delete the selected group 

Clear this group Clear the selected group 

Rename this group Rename the selected group 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

 

Measure values' menu 

 

 The context menu that appears above the group cell: 

Command Function 

Sort ascending  Range the cells in the column by values from the 

bottom to the top  

Sort descending  Range the cells in the column by values from the top 

to the bottom  

No sorting  Remove any sorting  

Filter on captions  Set the filter for measures 

Hide these measures Hide the selected measure 

Show as Specify the display mode of the current measure in 

the Grid: 

default 

percent aggregated value in the row 

percent parent element of the row 

percent parent element of the column 

percent total aggregated value 
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Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering, 
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the Hierarchy 
Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for each element 

independently. 

The buttons for launching the editor ( ) are placed on the 
panels in the Hierarchy levels’ area. If the button looks like 
this ( ), it means the hierarchy had hidden members inside. 
Pressing the button starts the Hierarchy editor. 

 

 
 
6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary with 
the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To return to the 
original width, double click the right boundary of the column where it is visible. In case there were such changes in the table that 
saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the column with the 
assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, calculating the columns’ 
width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width will be set to default, but it 
can be corrected later. 
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17.3 Working with OLAP Chart 
 

While the Grid view allows working with numbers, chart view allows representing your helpdesk data graphically. This gives 

you and other managers a unique opportunity to analyze helpdesk data visually, dealing with charts rather than numbers, 

which is much easier to perceive. Now it’s easier than ever to spot new trends and discover unknown problems in your data 

flow. The statistical tool will help you gain an insight into your data and make new discoveries. 

 

 
 

Tools panel 
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options. 

Button Function 

 Load the Grid state 

 Save the Grid state 

 Export OLAP-slice data 

 Print OLAP-slice data 

 Preview 

 Undo 

 Redo 

 Switch axes 

 Select the docking panels layout 

 Set the scale of Chart display 

 Select the color palette for measures 

 

 

Modifier panel 
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using 
different shapes and sizes, so that you can easy distinguish them in a single graph. You can simply place a dimension or a measure on 
a modificator’s pane and get the graph showing different values in a different manner. 
 
For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in 
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. The 
same can be done for Shape and Size so that you can make your data perfectly distinguished. 
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The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an 
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the color 
and shape of an element, the appropriate parameters can be amended. 
 

Modifier The changes made upon placing a Chart element to the modifier area of... 

a measure a hierarchy 

 

  

The color of the Chart elements will be 

chosen from the standard set of gradient 

colors  

 

Hierarchy members will be painted with 

the colors from the current palette 

Color The elements with the minimal value will 

be painted with the first of the gradient 

colors, and the elements with the 

maximal value - with the last one 

 

N/A 

Size Depending on the value of the measure 

the size of the Chart points will vary 

from the minimal to the maximal. 

 

Hierarchy members will differ in size 

Shape Forbidden Hierarchy members will differ in shape. 

If the number of hierarchy members will 

exceed the number of available shapes, 

some of them will be used more than 

once 

Details Forbidden The panels will display series for all 

hierarchy members 

 
If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to spot 
the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart elements. While 
the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its content, turn to the 
legend panel. 
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The Legend panel 
The panel contains descriptions of the modified elements. 
The value, shape and color of a legend element can be 
edited. 

Setting the Color legend 
To select a color, simply double-click the appropriate element 
and choose a color from the pop-up editor. 

 

 

Setting the Gradient legend 
To edit the gradient, double-click the element and tune the settings in the 
editor. In the Gradient Editor there are: 

• a set of pre-made gradients;  
• selecting gradient option (continuous or discrete);  
• creating a gradient with a set number of intermediate colors option;  
• setting threshold in per cent and measure values option;  

 

Selecting threshold color option. 

 

 

 

 

Setting the Shape legend 
The shape selection is made through the context menu. This 
option is available only for points or lines Charts. If the 
number of hierarchy members exceeds the number of 
available shapes, they will be repeated. 
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Chart Panes 
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.  
 

 
Measure groups with corresponding Charts in the working area 

  

Chart Type 

In the upper left part of each Chart, there will appear a 
context menu for selecting its type. There are six (6) charts 
that you can use, namely, Point Chart, Histogram, Point 
Shape Selection, Lines, Curved lines and Step lines. By default, 
the Histogram is used. 

 

The size of Charts can be changed to some extent. To expand 
a Chart along either one of the axes, you need to capture its 
boundary with the mouse and drag it. You can change the 
size along both axes (and return to default) through the tool 
menu in the upper part of the working area. 

 
Chart type menu 

 

  

Hot keys for changing the scale 

Ctrl+* Reset Scale to 1:1 

Ctrl+Num+ Zoom In 

Ctrl+Num- Zoom Out 

 
Navigation 
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse wheel. To 

scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift. 

 
Selecting Data 

You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points, 

holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that 

case, the corresponding hierarchy members will be filtered automatically. 

 

 

 

Selecting and filtering parts of Charts 
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a. Selecting some of the Chart points 

 

b. Selecting the Filter command 

 

 

c. The result 

 

Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is 
composed of them) or a range of values in Charts. 

 
Filtering hierarchies 

In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your 
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disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a 

number of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context 

menu. When you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members: 

• Hide this member  
• Hide all members except this  
• Hide all members above this  
• Hide all members below this  

Filter on hierarchy level 
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy 
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the 
same menu, there's a command to clear filter. 
 
Filtering hierarchy members 
If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose 
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.  
 

Filtering a single member of a hierarchy 
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the 
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.  
 

 
  

Filtering measures 

There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter. 
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17.4 Predefined Reports 
 

Predefined reports allow helpdesk managers and agents to quickly and easily 

retrieve information for common inquiries. Reports play a vital role as far as a 

Help Desk product is concerned. Requests that are open, closed or overdue at 

any instant of time, which person or company is sending the most number of 

requests & who is attending to the requests can all be known from the 

readymade reports available with the statistical tool. Each pre-defined report 

works in both OLAP grid and OLAP chart view.  

  

There are several predefined reports in each of the report categories, and 

each report is run directly on a mouse-click from the tree view. Around 40 

reports are made available for instant details about the help desk activities. 

Any of the predefined reports can be also be edited so you can customize the 

report to return specific results: 

 

• Reports by Cases 

• Reports by Callers 

• Reports by Date/Time 

• Reports by Problems 

• Reports by Agents 

 

All these categories have reports available based on Priority, Requester, 

Agent, Category and Request Date. 
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Some sample OLAP charts of the predefined reports 

 

A) Time spent on Asset 

 

 

B) Cases Count by Origin 

 

 
C) Average time spent on caller 

 

 

D) Due date  

 

 
  

E) Cost per problem category 

 

F) Time spent by agent 
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 Back to TOC 

P
ag

e9
5 

17.5 Printing, exporting statistical data and charts  

 
Now that you have successfully designed a report, you might want to save it for future reference or share it with others. 

Reuse your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML 

as a simple way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved 

file would either take the grid data or the chart. 

 

 

 

 

Available export formats in Chart View  Available export formats in Grid View 

 

Printing 
You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer settings 
before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide range of formats 
including PDF, XLS, CSV, JPG, etc. 
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Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can 
specify the page size, orientation, headers & footers and color of the fonts and page background. 
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18. Uninstalling Helpdesk Agent add-in  
 

To uninstall the AssistMyTeam Helpdesk Agent add-in from your computer, follow the steps outlined below: 

 

Step 1: Go to ‘Control Panel > Programs and Features’.  Scroll down to select ‘AssistMyTeam Helpdesk Agent (x86) or (x64)’ 

and click ‘Uninstall’ as illustrated below: 

 

 
 

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.  

 

 
 

Step 3: The AssistMyTeam Helpdesk setup will now start the un-installation process. Make sure that Microsoft Outlook is not 
running (even under the task manager). 
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29. Important links  

AssistMyTeam Helpdesk for Outlook - Home page 

Go to the official website of AssistMyTeam Helpdesk for Outlook.  

  

Video Tutorial clips  

Watch video tutorials that teach you how to install, configure and work with AssistMyTeam Helpdesk.   

   

Purchase License  

Purchase an enterprise team license for AssistMyTeam Helpdesk for Outlook.   

   

Knowledgebase articles  

Looking for an in-depth understanding of this application? Browse through a series of knowledge base articles 

on AssistMyTeam Helpdesk online.  

   

Support Maintenance contract  

At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more! 

The AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that 

you encounter during the course of their use.   

   

Submit an online support ticket  

Use this web form to create a ticket with AssistMyTeam Technical Support.   

   

 

https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/video-tutorials/
http://www.assistmyteam.net/TeamTimeSheet/TutorialClips.asp
https://www.assistmyteam.com/helpdesk-addins/purchase/
http://www.assistmyteam.net/TeamTimeSheet/Purchase.asp
https://www.assistmyteam.com/helpdesk-addins/kb/
http://assistmyteam.net/KB/index.php?option=com_content&view=category&id=3
https://www.assistmyteam.com/support/
http://www.assistmyteam.net/support/
https://www.assistmyteam.com/support/submit-ticket/
http://www.assistmyteam.net/support/submitTicket.asp
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